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Welcome to the SnapShot Help.

From this page you can get Help on any of SnapShot's procedures and menu options or you can learn 
more about Help itself.

Click on a button to make your choice.
          What is SnapShot?  
          The SnapShot window  
          How To...  
          Menus  
          Using the SnapShot Help  
          About IMSI  

To choose a Help option...

Point to your choice and click.

Use Tab to highlight your choice, then press Enter.

For more information about using help, click on Using the SnapShot Help above.



How To...

Click on a button for more Help with SnapShot's procedures.
          Snap the whole screen  
          Snap a window  
          Snap a region  
          Snap an object  
          Change the HotKey  
          Control the SnapShot window  
          View your snaps  
          Save your snaps  
          Remove snaps from SnapShot  
          Use the Clipboard with SnapShot  



Menus

Click on a button to see a list of menu items.
          File menu  
          Edit menu  
          Capture menu  
          Help menu  



File menu

File menu
          New  
          Save As  
          Preferences  
          Exit  



Edit menu

Edit menu
          Cut  
          Copy  
          Clear  



Capture menu

Capture menu

The Capture menu lets you choose which part of the screen to snap.
          Screen  
          Window   
          Region   
          Object   
          Save Cursor   



Help menu
Help menu

          Contents  
          About  



What is SnapShot?

SnapShot is a utility that allows you to create a snap of all or part of the screen. You can snap the whole 
screen or just part of it, with or without the mouse pointer.

The snap can then be saved, and imported into a file in your drawing or desktop publishing application 
and printed.



The SnapShot window

Click on an area of the SnapShot window below to popup a description of the selected area.



Capture menu: Screen

Select Screen to snap the whole Windows desktop. This command is checked when selected.



Capture menu: Window

Select Window to snap the active window. This command is checked when selected.



Capture menu: Region

Select Region to snap an area of the screen which you define. This command is checked when 
selected.



Capture menu: Object

Select Object to snap the highlighted object. This command is checked when selected.



Capture menu: Save Cursor

Select Save Cursor to include the mouse pointer in the snap, if it is within the area being snapped.



Using SnapShot's Help

On-line Help is a convenient way to obtain information about using SnapShot.

You can keep the Help window permanently on-screen while you work by selecting Always on Top from
the window's Help menu. You may like to print out the Help because SnapShot is not explained in any of
IMSI's manuals. Printing Help is explained below.

Moving around SnapShot Help
As in all Windows Help applications, you move around SnapShot's Help to areas of interest using a 
system of 'jumps'. You can also 'pop up' definitions of specific words and phrases.

Most other Help systems show jumps as green text underlined with solid or dotted lines. In SnapShot's 
Help jumps are shown as buttons, and popup definitions are indicated by underlined regular (black) text.

This button appears throughout SnapShot's Help. It denotes a 'main' topic heading; another 
subject which may be relevant to the one you are currently reading about; a dialog box description; or 
more information of related interest. Click on the button, or on its title text, to 'jump' to its topic.

A definition is available for any underlined word or phrase. Click on the word(s) to 'pop up' the 
information.

Ways to choose a Help option...
To choose a Help topic, point to the button of the topic you want to read. The mouse pointer changes 
shape to a pointing finger. Click the mouse button to jump to that Help topic.

Alternately, you can press Tab or Shift Tab to highlight the button of your choice, then press Return to 
display that Help topic.

Once the topic you want to read has appeared in the Help window, use the vertical scroll bar to move 
through the Help.

Referring to related topics
Some topics are related to other topics. These related topics can be viewed by clicking on the See Also 
button which is positioned to the far right of the button bar.

A drop down list will appear. Choose the topic that you wish to read. 
If you are reading a topic which has no other topics related to it, the See Also button is disabled.

Click on the See Also button for an example.

Searching for Help
You can quickly search the Help system for help on a specific subject. To do this

1. Click on the Search button in the Help window's button bar. The Search dialog box will appear.

2. Scroll through the list of subjects and choose the one you would like to read about.

3. Click on the Show Topics button. A list of the topics associated with that subject will appear. Select 
a topic.

4. Choose the Go To button. Information on your selected topic will appear in the SnapShot Help 
window.

You can then scroll through the Help as described earlier.

Browsing and Backtracking
Use the Browse buttons at the top of the Help window to browse backwards and forwards through the 
surrounding help information. 



Click on the Back button in the Help window's button bar to backtrack a step at a time up the hierarchy 
of topics you have reviewed in this Help session.

Click on the History button to display a list of the most recent topics you have reviewed in this Help 
session. Double-click on a topic to display it in the main Help window.

Printing Help
You can print the Help so that you have a hard copy to refer to. To print the current Help topic, select 
Print Topic from the File menu of the Help window. The current Help topic is printed to the currently 
selected printer.

To choose a different printer, or to change the default printer options, select Print Setup from the File 
menu of the Help window and choose the printer that you want to print to. For Help with this dialog box 
click on the Help button.

Note: You cannot print information that is in a `pop up' window.

Canceling Help
Click on Close from the Help window's Control   menu  , or press Alt F4.



See also:

This is an example of the topics that might appear after selecting the See Also button.
          How to snap an object  



Snapping the whole screen

You can take a snap of the whole Windows desktop, so that everything you can see on your screen is 
snapped.

To snap the whole screen

1. Select Screen from the Capture menu. (If SnapShot is iconized, click on it to display its Control     
menu then select Screen from the Capture submenu.)

2. Select Save Cursor from the Capture menu if you want the mouse pointer in the snap. (If 
SnapShot is iconized, click on it to display its Control menu then select Save Cursor from the 
Capture submenu.)

3. Arrange your Windows desktop how you want it to be snapped. Position the mouse pointer 
suitably.

4. Press the SnapShot HotKey. The mouse pointer temporarily changes to a camera shape, 
indicating that a snap has been taken.

If the Hide before snap check box in the Preferences dialog box is selected, SnapShot will be 
iconized as you press the HotKey so that its window is not accidentally snapped.

If the Show after snap check box in the Preferences dialog box is selected, SnapShot will 
become the active window so that you can view your snap.

You could now re-arrange your desktop and take another snap, or save the snap you have just taken.



See also:
          How to save your snaps  
          Preferences   dialog box  



Snapping a window

You can take a snap of the active window.

To snap a window

1. Select Window from the Capture menu. (If SnapShot is iconized, click on it to display its Control
menu then select Window from the Capture submenu.)

2. Select Save Cursor from the Capture menu if you want the mouse pointer in the snap. (If 
SnapShot is iconized, click on it to display its Control menu then select Save Cursor from the 
Capture submenu.)

3. Make sure the window, icon or dialog box that you want to snap is active. If you are snapping the 
mouse pointer, position it suitably.

4. Press the SnapShot HotKey. The mouse pointer temporarily changes to a camera shape, 
indicating that a snap has been taken.

If the Hide before snap check box in the Preferences dialog box is selected, SnapShot will be 
iconized as you press the HotKey so that its window is not accidentally snapped.

If the Show after snap check box in the Preferences dialog box is selected, the SnapShot 
window will become active so that you can see your snap.

You could now make another window active and take another snap, or save the snap you have just 
taken.



See also:
          How to save your snaps  
          Preferences   dialog box  



Snapping an area

You can take a snap of any area of the Windows desktop.

To snap an area

1. Select Region from the Capture menu. (If SnapShot is iconized, click on it to display its Control     
menu then select Region from the Capture submenu.)

2. Select Save Cursor from the Capture menu if you want the mouse pointer in the snap. (If 
SnapShot is iconized, click on it to display its Control menu then select Save Cursor from the 
Capture submenu.)

3. Arrange your desktop so that the area you want to snap is visible. If you want to snap the cursor, 
put it in a suitable position.

4. Press the SnapShot HotKey. The SnapShot Zoom Lens appears and the mouse pointer changes 
shape to two cross hairs and a pair of scissors. If the Save Cursor option is selected, a copy of 
the shape of the mouse pointer before the HotKey was pressed is left on the screen. You can't 
move this until the snap has been taken.

You can cancel the HotKey command and return to regular use of the mouse pointer by pressing 
ESC at any time before the snap is actually taken.

5. Put the mouse pointer at one corner of the area you want to snap. Hold down the left mouse 
button (or press Enter) and then drag the pointer diagonally across the area to snap. When you 
release the mouse button (or press Enter again), the snap is taken. The mouse pointer 
temporarily changes shape to a camera, 

You can use the arrow keys on the keyboard together with the Zoom Lens to accurately move 
and position the mouse pointer in one pixel increments.

Hold down Shift while using the arrow keys to move the mouse pointer in increments of eight 
pixels. 

Hold down Ctrl while using the arrow keys or the mouse to limit the size of the area being 
snapped to multiples of 8 pixels.

If the Hide before snap check box in the Preferences dialog box is selected, SnapShot will be 
iconized as you press the HotKey so that its window is not accidentally snapped.

If the Show after snap check box in the Preferences dialog box is selected, the SnapShot 
window will become active so that you can see your snap.

You could now snap another region, or save the snap you have just taken.



See also:
          How to save your snaps  
          Preferences   dialog box  



Snapping an object

You can take a snap of a Windows object.

To snap an object

1. Select Object from the Capture menu. (If SnapShot is iconized, click on it to display its Control     
menu then select Object from the Capture submenu.)

2. Select Save Cursor from the Capture menu if you want the mouse pointer in the snap. (If 
SnapShot is iconized, click on it to display its Control menu then select Save Cursor from the 
Capture submenu.)

3. Press the SnapShot HotKey. The mouse pointer changes shape to a camera. The edges of the 
object under the center of the camera lens will be highlighted. You can change the selected object
by moving the camera. 

At this stage you can cancel the HotKey command and return to regular use of the mouse pointer 
by pressing ESC.

4. When the object you want to snap is highlighted, click the left mouse button. The snap is taken 
and the mouse pointer resumes its regular shape. The snap will be exactly what you see on your 
desktop within the edges of the highlighted area.

If the Hide before snap check box in the Preferences dialog box is selected, SnapShot will be 
iconized as you press the HotKey so that its window is not accidentally snapped.

If the Show after snap check box in the Preferences dialog box is selected, the SnapShot 
window will become active so that you can see your snap.

You could now snap another object, or save the snap you have just taken.



See also:
          How to save your snaps  
          Preferences   dialog box  



Viewing your snaps

SnapShot can handle up to 24 snaps at any one time, the four buttons at the bottom left-hand corner of 
the SnapShot window are used to flick through the snaps displayed on screen.

Press this to view the first snap (Shortcut Home).

Press this to view the previous snap (Shortcut Pg Up).

Press this to view the next snap (Shortcut Pg Dn).

Press this to view the last snap (Shortcut End).

The Image counter on the information line displays the number of snaps currently in SnapShot and 
which snap is displayed on screen.



Changing the HotKey

The HotKey is used to take a snap, and can be any combination of the function keys F2 to F12 and the 
Shift and Control Keys.

How to change the HotKey

1. Select Preferences from the File menu or SnapShot's Control   menu  . The Preferences dialog 
box will appear.

2. In the HotKey group box, check the Control and Shift boxes and select a function key from the 
drop-down list box to create the HotKey combination that you want to use.

3. Click on OK to close the Preferences dialog box with the new HotKey combination. 



See also:

    Preferences   dialog box  

    Controlling the SnapShot window  



Controlling the SnapShot window

You have some control over when and how the SnapShot window appears during a snapping session.

How to control the SnapShot window

1. Select Preferences from the File menu or SnapShot's Control   menu  . The Preferences dialog 
box will appear.

2. From the Display group box check the Hide before snap box to iconize the SnapShot window 
when the HotKey is pressed; check the Show after snap box to make SnapShot the active 
window after each snap has been taken; check the Stationary Zoom Lens box to lock the Zoom 
Lens in one corner of the screen until the mouse pointer is moved over it. If this box is clear the 
Zoom Lens will appear in the corner nearest to where the mouse pointer is, or the center of the 
screen if the mouse pointer is positioned in one of the corners.

3. Click on OK to close the Preferences dialog box with the new SnapShot window options. 



See also:

    Preferences   dialog box  

    Changing the HotKey  



Saving your snaps

When you have taken your snaps, you can save them for later use, e.g. to import into a file in your 
desktop publishing application, or use as a Windows wallpaper.

How to save your snaps

1. Display the snap you want to save.

2. Select Save As from the File menu. The Save As dialog box will appear.

3. Select the disk drive, directory and file format in which you want to save the snap. You can save 
your snap in three different formats:

PC Paintbrush    format (*.PCX)
Windows bitmap (*.BMP)

TIFF    (*.TIF)

4. Enter a name for your snap in the File Name box, then click on OK. The snap is saved to the file 
of that name.

If you omit the file extension, it will be added for you, though you can specify an alternate 
extension if you prefer.

If you enter a filename that already exists, you will be asked if you want to overwrite the existing 
snap. Click on Yes or No as appropriate. Clicking on No redisplays the main SnapShot window 
for you to use the Save As command.    Clicking on Yes overwrites the previous snap.



Removing snaps from SnapShot

You can remove all the snaps from SnapShot at once, or remove a snap individually.

How to remove all the snaps

Select New from the File menu, all of the snaps will be removed. If there are any untitled snaps, a 
message will appear giving you the opportunity to save them.

How to remove one snap

1. Display the snap you wish to remove.

2. Select Clear from the Edit menu. The snap currently displayed will be removed. If the snap is 
untitled, a message will appear giving you the opportunity to save it.



Using the Clipboard with SnapShot

You can copy snaps from SnapShot to other applications.

How to copy a snap into another application

1. Display the snap you want to copy.

2. Select Copy from the Edit menu.

The snap is copied onto the clipboard and can be pasted into another application.
Select Cut from the Edit menu to put a copy of a snap onto the Clipboard, removing it from 

SnapShot.
You cannot Paste anything into SnapShot. If you accidentally Cut an unsaved snap to the 

Clipboard, Paste the snap into Paintbrush (supplied with Windows) then save it.



File menu: New

Select New when you want to clear SnapShot of its contents and start again. All of the snaps held in 
SnapShot will be removed. (Like changing the film in a camera.)

If SnapShot contains any unsaved snaps, a message will appear giving you the opportunity to save 
them using the Save As command.

Keyboard shortcut:
Ctrl N



File menu: Save As

Select Save As to save the snap displayed on screen. The Save As dialog box appears.

Choose a drive and a directory in which to save the snap, choose the file format you need and enter a 
name for the snap.

Keyboard shortcut:
Ctrl S



See also:
          Saving your snaps  



File menu: Preferences

Select Preferences to specify the HotKey used to take a snap, and to specify how the SnapShot 
window and Zoom Lens behave when taking a snap. The Preferences dialog box will appear.

Keyboard shortcut:
Ctrl P



See also:
          Preferences   dialog box  



File menu: Exit

Select Exit to close SnapShot. If SnapShot contains any unsaved snaps, a message will    appear giving
you the opportunity to save or abandon the snaps, or to cancel the Exit command.

Keyboard shortcut:
Ctrl Q



Edit menu: Cut

Select Cut to remove the snap currently displayed and put it onto the Clipboard ready to be pasted into 
another application, e.g. TurboDraw.

Keyboard shortcut:
Ctrl X



Edit menu: Copy

Select Copy to copy the snap currently displayed onto the Clipboard without removing it from SnapShot.

Keyboard shortcut:
Ctrl C



Edit menu: Clear

Select Clear to remove the snap currently displayed. If the snap has not been saved, a message will 
appear giving you the opportunity to return to the main SnapShot window to use the Save As command 
or to abandon the snap.

Keyboard shortcut:
Ctrl D



Help menu: Contents

Select Contents to display the Contents page of the SnapShot Help. From the Contents page you can 
choose which part of SnapShot you want Help on.



Help menu: About

Select About to display the SnapShot billboard. This shows the version number of your copy of 
SnapShot and a copyright notice.



Preferences dialog box

This dialog box will appear when you select Preferences from the File menu or SnapShot's Control     
menu.

From this dialog box you can change the HotKey, and decide how the SnapShot window and Zoom 
Lens should behave when the HotKey is pressed.

HotKey group box

You must choose one of the function keys to be part of the HotKey combination.
Check the Control and/or Shift boxes as needed if you want to make them part of the HotKey 
combination. 

Some applications, e.g. TurboDraw, use the function keys as shortcuts. When you specify a 
HotKey that does not include Shift or Control, the function key is used as the HotKey, not the shortcut in 
the other application.

Display group box

Click on the Show after snap box to make SnapShot the active window after each snap is taken.

Click on the Hide before snap box to icons the SnapShot window when the HotKey is pressed. This 
prevents the SnapShot window from being accidentally included in the snap.

Click on the Stationary Zoom Lens box to lock the Zoom Lens in one corner of the screen unless the 
mouse pointer is moved over it. If this option is not selected, the Zoom Lens will appear in the corner 
nearest    to where the mouse pointer is, or the center of the screen if the mouse pointer is positioned in 
one of the corners.



See also:
          How to change the HotKey  



IMSI Software
for Home and Small Business

Presidents Letter.-
IMSIs goal is to provide you with the highest quality software products at affordable prices.    Since 1983,
millions of our award-winning products have been purchased throughout the world.    This catalog 
presents our most popular titles.    Most are Windows 95 compatible.    Some of these products are on 
the CD you have just purchased, and can be accessed by simply calling us!    Other products can be 
tried for FREE by downloading them from our Internet WEB site.    We invite you to try them and enjoy 
them.

Sincerely,

Martin Sacks, CEO and President

Instant Access to IMSI Products via CD Unlocking & Internet Downloading:
You may find several other IMSI software products on your CD!    These products can be unlocked by a 
simple phone call to us to purchase your special access code.    Check your CD today! Some IMSI 
software can also be downloaded for FREE on the Internet at http:\\www.imsisoft.com.

Two Special Offers to Our Customers!
A 25% discount off the retail price for any purchase directly from IMSI of any products in this catalog.    

And a FREE -MasterClips 1000 (award-winning color clip art - $19.95 value) with every order!

Where to Find Information 
Internet WEB Site http:\\www.imsisoft.com

CompuServe GO IMSI, GO TURBOCAD, GO FORMTOOL

FAX INFO 415-257-3000 ext. 4

Technical support 415-257-3000 ext. 3
support@imsisoft.com

Sales Orders 800-833-8082    

FAX 415-257-3565

Bulletin Board 415-257-8468 N-8-1

GST Technology Ltd is a worldwide software developer at the leading edge of user interface design for
desktop publishing and graphics technology under Windows.    GST is the author of SnapShot, 
developed specifically for IMSI and licensed to them.

GST has a range of other products in the desktop publishing and graphics fields sold worldwide by a 
variety of licensees.

GST contacts are:

Europe
GST Technology Ltd, Meadow Lane, St. Ives, Huntingdon, Cambridgeshire, PE17 4LG, UK.
Telephone: +44 (0)1480 496789
Fax: +44 (0)1480 496189
Email: postmaster@gst-soft.demon.co.uk

USA
GST USA representative office, PO Box 5224, Englewood, CO 80155-5224, USA.
Telephone: +001 (303) 680 9121



Fax: +001 (303) 680 5611

Copyright © 1995 GST Technology Limited.



Directory
Part of a structure for organizing your files on a disk. A directory can contain files and other directories 
called sub-directories.



Snap
A picture of all or part of the screen. Snaps are saved as bitmap images.



HotKey
The key or combination of keys pressed to take a snap with SnapShot.



Active Window
The active part of the screen, it may be an application window, a dialog box or an icon. The active 
window has a highlighted title bar.



File
A document stored on a hard or floppy disk, or other media.



Scroll bar
A bar that appears at the bottom and/or right edge of a window whose contents are not entirely visible.



Control menu

 A standard Windows menu displayed by clicking on the bar shaped icon at the top left of a window, or 
clicking on an application running as an icon.
By using Control menu commands you can, resize, move, maximize, minimize and close windows, and 
switch to other applications.

The SnapShot Control menu also contains commands to define what is captured, to specify your 
SnapShot preferences and to display the SnapShot billboard.



PCX
A file format used by PC Paintbrush.



Windows Bitmap (BMP)
The standard Windows bitmap file format.



Tagged Image File Format (TIF)
A standard file format often used by scanners.



Zoom Lens
A window which appears when snapping an area. It shows an enlarged view of the area around the 
mouse pointer.



Pixel
One of the dots making up the picture on the screen.



Clipboard
A mechanism provided by Windows for transferring data between applications. In SnapShot the Cut and
Copy commands transfer data to the Clipboard. The Paste command can then be used in another 
application to transfer the data.



Object
Objects may be windows, menus, buttons, parts of dialog boxes, icons or the whole screen.



Information Line

The Information line at the bottom of the SnapShot window provides the following information:
Image displays the number of snaps currently in SnapShot, and which one will appear on screen.
Size displays the width and height in pixels of the snap displayed on screen. The last number 

indicates the maximum number of colors that your screen supports.
File displays the filename of the snap displayed on screen. If the snap has not been saved, it is 

shown as 'untitled'.



Last Snap
 Click on this button to display the last snap in SnapShot.

Keyboard shortcut: 
End



Next Snap
 Click on this button to display the next snap in SnapShot.

Keyboard shortcut:
Pg Dn



Previous Snap
 Click on this button to display the previous snap in SnapShot.

Keyboard shortcut:
Pg Up



 First Snap
 Click on this button to display the first snap in SnapShot.

Keyboard shortcut:
Home



SnapShot display area
The snaps you have taken are displayed here. Use the buttons at the bottom of the window to flick 
through the other snaps you have taken.



Menu bar
Click on a menu name to display the menu's commands.



 Control menu box
Click on the Control menu box to display the SnapShot Control menu. By using Control menu 
commands, you can resize, move, maximize, minimize, and close windows, and switch to other 
applications.

The SnapShot Control menu also contains commands to define which part of the screen 
SnapShot captures, to specify your SnapShot preferences and to display the SnapShot billboard.
Keyboard shortcut: Alt Spacebar



 Minimize button
Click on the Minimize button to reduce the SnapShot window to an icon.

When you reduce SnapShot to an icon, it continues to run but its window does not take up space 
on your desktop.



 Maximize button
Click on the Maximize button to enlarge the SnapShot window to its maximum size.

After you enlarge SnapShot, the Maximize button is replaced by the Restore button, which 
contains both an up and a down arrow.    Click on the Restore button to return the SnapShot window to its 
previous size.



 Title bar
The title bar shows the name of the application, in this case, SnapShot.

You can maximize SnapShot by double-clicking on its title bar.    To restore it to its previous size, 
double-click on the title bar again.

To move SnapShot to a different location on your desktop, drag its title bar to the new location.




